User Manual for DOP-W Series

DOP-W Series have 3 Models type with DOP-W105B, DOP-W127B and
DOP-W157B.
Before introduce function of DOP-W series, there is something to describe how
to enter system menu and how to download the screen data to HMI.
B How to enter system menu
» Method 1 ~ Please start the DOPSoft software and create System
Menu button, after downloading the screen data to HMI, press the
System Menu button to enter the system menu.
» Method 2 ~ Please press at blank space for a while, and then will hear
Buzzer sound and display as below following windows for asking
users Enter the system menu.

Enter the systern menu?

YES NO

B How to download the screen data to HMI
DOP-W Series did not provide download or upload via USB translation. It
is only way for download and upload screen data via Ethernet or COM
Port. The default Upload and Download way is Ethernet. Detailed
explanation for download and upload, please refer to P.252~2509 of
Chapter 2 in DOPSoft User Manual. The default Upload and Download
way is Ethernet.

System Path

CPROGRAM FILES (X86)\DELTA INDUSTRIAL AUTOMATION'DOPSOFT 21| | ..

Output Path
C:PROGRAM FILES (X86) DELTA INDUSTRIAL AUTOMATION'DOPSOFT 2 D

Options
ToolBars Windows Language

7] Text Bar [English =
S

) Bitwep Bar UploadDowaload

[¥] Zoom Bar ©UsB © Ethernet

[ Layout Bar ©PCCOMPort | COMI

[¥] Property Table =

_ [C] AutoSave ... Time Interval ] = o
[¥] Output Bas

[] Auto Open Last File when starting SerEditor
[] Center Drawing Area

[ Inchuds Picture Data when uploaging

[7] Anto Conrvert Input Address To Tag Name

7] Auto raboot after fimmware upgrading

Recips CSV Separator | -

| ER | Reinstall HMI USB Driver H Uninstall HMI USB Driver ]

o e |
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If users select Ethernet to download, please enter the system menu to set
DHCP to OFF and set the IP address manually at first.

DOP-W - [ system Settinge A Home

LAN 1 HMI Name: HMI

LAN 2 DHCP : OFF

P SIEZESEBS P8 S

Mask ooy . 208 2o 0

Gateway : 0. 0. 0. 0

L]

-

Network

DOP-W Series provide two Ethernet LAN devices to download and upload

screen data or recipe, get firmware information and reset HMI. It also

could plan two Ethernet LAN devices in different domains for application.
As below will introduce functions for DOP-W Series.
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1 ~ Password Setting

Password setting is used to divide user level with HMI. The security level
involved 0 to 7 and has default password in every security level. DOP-W
Series also provide multi-account and password to let several users log in to
HMI.

NOTE :
v' Password cannot be set as empty.

Security Level: 0 -

ID | Account |Pas&wm'd
[T o

Add

|83

DOPSoft elete

oK |

|
IQI There are blank fields in the password dialog.

o

—s—

v" Please do not set the same account in the same security level, but it could
set the same password in the same security level.

v" The account could set the same in different security level. For example, if
security level 0 set account to 123, the 123 account also could set in
security level1.

v" The length limitation for account and password is 24 characters.

v' The account and password are case insensitive. It will only display the
capital letters.

No protection function is available. Any person can

Security Level 0
operate the system.

Security Levels | Entry of password or override with high permission level
1~7 is required to operate the system.

This is password for the highest permission level and is
higher than those for levels 1 ~ 7. Meanwhile, this
Security Level 8 | password is the protection password once a project is
saved and is also used for Check password when
download program and system file formatting.

(Table 1-1) Table of permission levels
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When the user wants to change the password in each level, this can be done
by changing the password entry through [Options]—> [Password Setting]. The
length limitation for account and password is 24 characters. The entered
password can have up to 8 digits, which consist of numbers of 0 ~ 9 and
alphabets of A ~ F regardless of capitalization or lower-case. The user can

choose the digits and characters of the password as preferred with flexibility.

Security Level: 0 4

D |Am\mt |Pmswmd |

1 0 00000000

Add

Delete

Cancel

1l

(Figure 1-1) Password Editing

When users set the same account in the same security level, HMI will display Account

Duplicate error message.

[Coos || o |

0 00000000
xo0 accounTasswomD x|
LEVEL ,0—
ACCOUNT |l]
PASSWORD |1
ool |

=
0 00000000

Account Duplicate!

OK

(Figure 1-2) Duplicate for Account setting
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Users also could via Password table setup element to change account and
password.

= o | o]

I [
No |Account ]Password

0 00000000

(Figure 1-3) Password Table Setup button

Or enter system menu and select System setting > Security to change account and

password.
DOP-W - [ System Settinge ﬁ”ome
No 1Accou nt ;Password
0 00000000

Se(-:urity

(Figure 1-4) Password setting in system menu
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2 ~ Multimedia

DOP-W Series provides multimedia player used to play operation and
maintenance instructions video, so that each operator can have a clear and
straightforward, and thus more effective to reach work; or standard operating
procedures used to play video presentation to help user who establish a good
working environment.

Video can be selected directly or video files you would like to play within the
Word register values to specify a different video files to play

Note :

v" One screen only could establish one video element.
Sub screen could not establish video element.
Base screen could not establish video element.
Video element did not support rotate function.

The video format only support WMV file.

AN N NN

Video can be described with three major items:
(1) Video Lists Output Setting
(2) Control Address
(3) Play List

(1) Video Lists Output Setting
This function involves add, delete, export, and where to save the video files.

Users could select Options = Video Lists Output Setting to add video files.

Video List

D |save Loca| Video Name | source [ Add I
Delete

Export

I [ 0K J ‘ Cancel

(Figure 2-1) Video Lists Output Setting
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(2) Control Address
It is used to control video play or stop.
Users could select Element->Multimedia to create video.

Video I, ==
Freview | Wain Coordinates
| Control None Bl
Play List
D |Mode |Name E
- (]
g
Languagel
DF\epeat
! = |

(Figure 2-2) Control Address

(3) Play List

Play List decides if the video file is to be played through select directly file or
set Word register values to specify a different video files to play.

-
Video

I, ==
- M- Coordinates

Preview

Control None E]
Play List
D [Mote |Name E
=

Language:

Languagel

"1 Repeat

(o ) )|
|

(Figure 2-3) Play List
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Video Lists Output Setting, Control address, and Play List are described in the
details below.

Video Lists Output Setting
(Table 2-1) Video Lists Output Setting
U HEES.,. ==

Video List

D | Save Loca| Video Name | Source |

Add

| [ox ][ cmemt |

€ Description of Add, Delete Export button for video file
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Video Lists Output Setting
(Table 2-1) Video Lists Output Setting

» Once the Add button is clicked, the software will ask the user
to select the video file to be played.

[l open el
Look in | Video - & G i Sl i
R= Name = Date modified Type
e #9600 10/24/20121517  Windows
RecentPlaces 5195500 10/24/20121518  Windows
! |H Entry 3/19/2014 15:07 Windows
|H History 3/19/2014 15:07 Windows
Desktop [ iPad 5/8/2014 16:27 Windows
—— B Timer 3/3/2014 15:30 Windows
::_:TJ |E Toml 3/3/201415:35 Windows
Libraries |E| Tom2 3/3/2014 15:38 Windows
B
Lh,h-.‘_.
Computer
AJ 7 i ] b
Mebwork .
Fiesoftype: [ Microsoft Windows Media Video("wmy) -] [ caneel |

» The user can add up to 999 (1 ~ 999) video effect files.
> If add the 1000™ video file, it will display as below following
message to inform users.

Video List

Add

Swelooa| VidsoName | Souos | -
GE om0 £ DupSoft Cases User PLC Boudiste 2600 wme g
UsB 115200 E:\DopSoft Cases User PLC Boudrate'115200.wme Delete
oy E:Daploft Cases Sampl: History e

Eniry E:\DopSoft Cases Sampls Entrywmv
USR Time E Doptoft Cases Sample Times e

i)

ml ..|ou|..,.|h|u|...|.-, ]
&

sD Videol01

= &0 Videodd W, Masimum number of filas
i Jso Videol03

ESB VideolOd

i s ideol3 oK
E_SJ VideolO6

14 |sp Videol7 2 i S g e Vi o e 2 Y
15 |so Vidso08 C/Docunsents and Settngs daisy g ATETRAER
16 |so Videol0P CDocumants and Ssttings daisy many SRR
7 5D VideoD1D O\ Documents and v ey MU ARER
Es: Videol11 CDincumants and Satti i AR l. Export
hd N idanli1? [ Termmante and Ssbbmecidnor mans S SR

| 0K Cancel

» Once the video to add is selected, could press Delete button
to delete a certain video file

» If delete multiple video files, one can click the video file or use
SHIFT + left button of mouse or Ctrl + left button of mouse to
select multiple file. Once the selection is done, one can click

Delete

the Delete button to execute deletion of video files.
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Video Lists Output Setting
(Table 2-1) Video Lists Output Setting

Video Lists Output Setting ==
Video List
D |Save Local Video Name | Source | o
| I sD Video0OL E/EMI_workDOP_W_Test.DOP-W 2.00.01.xx |
) sD Wigeol02 WF  E/EMI workDOP_W_Test DOP-W 2.00.01x
5 | Video003 E:HMIworkDOP_W._TestDOP-W 2.00.01xx_
& |so Video004 E:\EMI_workDOP_ W _TestDOP-W 2.00.0Lxx
|5 sD Video003 E:EMI_workDOP_W_TestDOP-W 2.00.01.xx
5 sD Vidzo006 E:EMI_workDOP_W_TestDOP-W 2.00.01xx_
N E) Video007 E:HMI_workDOP_W_Test DOP-W 2.00.01xx_
: sD Video003 E:\HMI_workDOP_W_TestDOP-W 2.00.01xx_

Ctrl + left button of mouse to select multiple file

> As below figure display delete selected video files.

Video Lists Output Setting =]
¥ideo List

ID | Save Loca| Video Name Source Add

1 sD Video002 E-HMI_work\DOP_W_TestDOP-W 2.00.01.xx_

PR ) Video03 E:EIMI_work\DOP_W_TestDOP-W 2.00.0L.xx, -

e elete

3 D Video04 E:EMI work\DOP_W_TestDOP-W 2.00.0L.xx_

s Video006 E:HMI_work\DOP_W_TestDOP-W 2.00.01.xx_

3 D Video07 E:EMI work\DOP_W_TestDOP-W 2.00.0L.xx_

5 | Video03 E:EMI work\DOP_W_TestDOP-W 2.00.0L.xx_

de,

» Before export video files, please select which device to save. It
can be set as USB or SD.

» When a video file is being exported, the software will ask the
user to select which device to save the file. Please note that
the root directory must be selected as the storage location.
Namely, do not save the video file in any file folder.

e TR OutpLtSeting =
Video List
D | Save Loca| Video Name Source | o
1 |uss  [videooor E:HMI_work DOP_W_Test DOP-W 2.00.01x%
2 JUSB |VideoOD2 Browse for Folder == Delete
3 Juss  |videooo3
4 Juse  |videoos
5 |uss  |videooos
- | HyperSnap & a
6 |uss  |videoos PerfLoas
7 Juss  |videonor , JJ Program Fles
B |usB  [videot0s , |, Program Files (x86)
. Users
+ ) Windows
> ey CD Drive (D)
HM hox (E: E
. |z hmi (Wboxsw) )
Mew folder I

| Export |

o [ amen |

»  After the video file is exported, one can see that the software is
executing the export.
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Video Lists Output Setting
(Table 2-1) Video Lists Output Setting

Video Lists Output Setting (=34

¥ideo List

D |Save Loca] Video Name Source o

1 USB  VideoOO1 E:HMI_workDOP_W_Test\DOP-W 2.00.01.xx

2 |uss vidso002 E:HMI_work DOP_W_Test\DOP-W 2.00.01.x% § e

e elete

3 USB  VideoOO3 E:HMI_work!DOP_W_Test\DOP-W 2.00.01 xx_§

4 |uss  videoOO2 E:HMI_work DOP_W_TestDOP-W 2.00.01.xx £

5 USB  VideoOOS E:HMI_work DOP_W_Test\DOP-W 2.00.01.x% §

6§ |uss  videolOS E:HMI_workDOP_W_TestDOP-W 2.00.01.xx_§

7 USB  Video0O7 E:HMI_work DOP_W_TestDOP-W 2.00.01.x%

B USB  VideoOO3 E:HMI_work DOP_W_Test\ DOP-W 2.00.01xx_§

Export

L | 8% [ 0K I l Cancel ]

» Upon completion of export, the software will notify the user
with a message that the video file has been exported.

Video Lists Output Setting =]
¥ideo List
ID | Save Loca| Video Name Source. v
1 USB  VideoOOL E:HMI workDOP_W_TestDOP-W 2.00.01xx &
2 USB  VideoDO2 E:HMI workDOP_W_TestDOP-W 2.00.01.5x_§ it
e elete
3 USB  VideoDO3 E:HMI workDOP_W_TestDOP-W 2.00.01.5x_§
4 USB  VideoOD4 E{HMI_workDOP_W_TestDOP-W 2.00.01 xx_E
5 USB  VideoOD3 E:HMI_workDOP_W_TestDOP-W 2.00.01xx_2
5 USB  VideoODS EHMi =
1 USB  VideoOO7 E:HM
8 USB  VideoDOS E:HM _

‘0' Files export are completed

Export

[ ok [ e |

€ Description of Field Name

> ID is a major reference value in playing video files. When the
user uses Address Read in the Play List, the software will
decide which video file to play according to the preset memory
addresses.
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Video Lists Output Setting
(Table 2-1) Video Lists Output Setting

TVideo Lists Output Setting ==
Video List

ID | ave Loca] Video Name Source o

1 SB VideoOOI ESEIMI_work DOP_W_TestDOP-W 2.00.01 x_f

Z SB VideoOO2 E-HMI_workDOP_W_TestDOP-W 2.00.01 xx_{

3 |psB vadeonos E-EMI_work DOP_W_TestDOP-W 2.00.01xx_§
4 SB VideoDO4 E:EMI_work DOP_W_TestDOP-W 2.00.01x%_§

5 SB VideoD03 E:EMI_work DOP_W_TestDOP-W 2.00.01x% §

§ SB VideoO0§ E:EIMI_work DOP_W_TestDOP-W 2.00.01x% §

7 bse videot7 ESEIMI_work DOP_W_TestDOP-W 2.00.01 x_f

8 5B VideoDO8 E-HMI_workDOP_W_TestDOP-W 2.00.01

Export

[ ok [ cment |

» Available Save Locations are USB and SD. The user can
change the Save Location as preferred with the default as SD.

Save "Video Lists Output Setting ==
. ¥ideo List
Location
SaveLocation | Video Name Source | o
USB | VideoOOL E-EMI_work' DOP_W_Test DOP-W 2.00.01.55 2

T e
» The filename of the video file added to the list will be displayed
as Video, with the first video file starting at 001 and the

T

Video

Name L . : .
following files go by Video001, Video 002 and Video 003.

» Source refers to the path and address of the video file after
being added. After adding the video file, the user can change
the source file, namely, replace other video files.

e len Output Setting =]
Video List
D |Savelocstion | Video Name Sovree ol G
I USE Video001 E/HMI workDOP_W_TestDOB-W 2.00, oiﬁ;gl
[ =
f_ Lookin: || Video - @f 2 E
Source L e
=1 W 2= s |k
= B NwikEn |
Libraries H Tom2 3/3/201415:38 Windows
L™
— etwerk File name: | - Open i L
Files of type: [Microsoft Windaws Media Video{"wmv) +] [ cemes | m
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Control Address
{Table 2-2) Control Address

Select Element > multimedia and create video.

Video
Preview - Main Coordinates
|Contro| None E]l
Play List
D [Mode |Name E]
State. E‘

Language:

|71 Repeat

Co )l

»  Control address only can be set as Word format to control video play
and stop action.
» It can be set as controller address and internal address.

Note :
v" I control addres set as $200, but user could create maintained button

to set address as $200.0. The operate behavior is press $200.0
means video play, relase the $200.0 means video stop.

Control address Play Stop
Controller address
D100 =1 D100=0
(Link1@D100)
, D200 =1 D200=0
(EtherLink1@D200)
Internal address
$200 =1 $200=0
($200)
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Play List
(Table 2-3) Play List

Select Element > multimedia and create video.

Video -E
Preview - Wain Coordinates

Control None [E

Play List

D |Mode |Name g
State: B
Language:

[ Repeat

e

» Play List includes Add play item @ and Remove play item.

» How the Play List is read depends on the video files added to be
played.
» The read methods include File and Address.

021-87700210

NIC SANAT r‘
s =l

-

www.nicsanat.com @



Play List
(Table 2-3) Play List

Video

Preview

- Main Coordinates
None

Control

Play List

[l

|m |Mode | Mame
[

» When Add play item is selected, the software will ask the
user to select the video files to be added to Play List.

Source

Add Video Lists Output Setting
State:
Video List
D [saveLoca] Video Name
I fuss  videotOr
R Juss  vadeo02
5 uss  videotts
& |use  vadeo0Ds
5 Juss  videot0s
6 |uss  video0s
7 uss  vigeott?
8 uss  videotts

E/EMI_workDOP_W_Test DOP-W
E/EMI_workDOP_W_Test DOP-W 2
EAHMI_workDOP_W_Test DOP-W
EAEMI_workDOP_W_Test DOP-W
E/EMI_workDOP_W_Test DOP-W
E/EMI_workDOP_W_Test DOP-W
E/HMI_workDOP_W_Test DOP-W
EAEMI_workDOP_W_Test DOP-W

2.00.01x_2

00.01.5x_¢

2.00.00.3_§
2.00.00.x%_F
2.00.01.x% 2
2.00.015 8
2.00.00.3 %
2.00.00.5% §

> After add video item to play list, the default Mode is File.
Users could change the Mode to Address or keep the
original setting as File.
» Users could delete unnecessary video file as needed
after add in play list.
» Select Video001 and press remove icon o
Videa
Preew ST prre—
Cantrol None E
Before i
Remove

>  After remove Video001 will display as below

figure.
Videa
Fraviaw - Main Coordinates
After Control None =
Play List
D |Mos: | ame | E
T VideoDll3 E__“
VidsoDild
VidsoDlls

> Mode includes File and Address.
Mode

» File: The user directly selects the video files to be played in
the list and add them to Play List. When the Word or Bit in
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Play List
(Table 2-3) Play List

Control List is triggered, the selected sound files will be
played.

Address: A certain register address will be designated. When
the trigger condition matches, the number entered into the
register will be read and the corresponding number in [Video
Lists Output Setting]—> [Video List] to play the associated
sound file.

Video

Preview - Main Coordinates

Control None E]

Play List

|1D Mode | Neme
fl File  _v| Video0D2

(3] ]

State: 2 T [Video003
- 3 Address 180004

4 File Video003
Language:

Langnagel

Address corresponding number, please refer to the example
shown below.

When the written address is 0, the corresponding number 1 to
play the video list; a value of 1, the corresponding list of video
playing number 2, and so on.

Yideo List
Play List
D |Save Loca| Video Name
1 USB 9600 D |Mode |Name |
2 UsB 115200 1 Address  {EtherLink2_1}1@D10
3 D History 2 |Address  {Etherlinkd 1}1@D11
4 sD Entry 3 Address  {EtherLink2 1}1@D12
5 USB Timer 4 |Address  {EtherLinkd 1}1@D13
6 USB Toml 5 Address  {EtherLink2 1}1@D14 [.J]
7 USB Tom2

Play

D |saveLoca] Video Name

T s om0 <+—» {EtherLink2_1}1@D10 50
D | Save Loca| Video N Play . ]

e —— «+—p {EtherLink2_1}11@D14 =1
i Juss 150

Pla
D | Save Locaf Video Name <—¥{EtherLinK2_1}1@D11 =2

s D History

Name

» Name is defined by the fixed filename video with number

starting at 001. The filenames of the subsequent files follow
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Play List
(Table 2-3) Play List

by Video002, and Video003, etc.

Play List
D Mode Name
1 File VideoO01
2 File Video002
5 File Video003
4 File VideoO04
5 File Video003

» If you check the repeat play, whether the mode is File or
Address, will be on the playlist of video play once, and then
playing from the first list of repeat play until the user stops the
action is triggered to stop playing.

Repeat

021-87700210

NIC SANAT r‘
s =l

-




€ The setup example of Video will be described below.

Example of Video
(Table 2-4) Example of Video

O Please select Options > Video Lists Output Setting and
press add button to select video.
Vi Lists Orpia Sefting =
et - e[=]
After add video, it will display as below figure.
"Video Lists Cutput Setfing (==
Video List
D |SaveLoce| VidsoName [ Source | | add
1_] 5D \jd_-oOJ] EHMI_work, DﬂP_W:_T:n‘DO’P—W: 200003 § .
i:}iﬁ o R Selain
— e
géo Viloll6 £/ HMI_morc DO Teat DB 20001 v §
7 |sp idea7 E:HMI_wortDOP_W_Teat DOP-W 20001 1 §
E 5D Videa 0§ E:HMI_wortDOP_W_Teat DOP-W 20001 1 §
® Please set Save Location as USB.
"Video Lists Output Setfing (==
Video Lists s |
o Save Locaf| Video Mame Source. Add
Output T few -
g_ USE Videol03 ESHMI_ work DOP W,_TestDOP-W 1.00.00xx 3 I Detete
Setting J i b e
T e [seons E\HMI work DOP. W Tost DOP-W 200,01 1 £
7 USE  [videol] EHMI vk DOP_ W, Taet DOP-W 2.00.01 12 §
¥ USE__x§ladealls E/HMI workDOE_W_TestDOF-W 100.00ms §
© Please press Export button.
Video Lists Output Setting (=]
Video List
D | Save Loca] Vidzo Harme Soures I e ‘
1 USE  VideoOO1 EHMI_work DOP_W_Teat DOP-W 20001 1§
T U viden EHMI_work DOP_W_Taat DOP-W 2.00.01 1§ I Delete ‘
B uss  vidw03 EHMI_work DOP_W_Teat DOP-W 20001 1§
4 uss videod EHMI_work DOP_W_Teat DOP-W 20001 1§
5 Juss  vidw05 EHMI_work DOP_W_Teat DOP-W 20001 1§
6 Juss  videiod EHMI_work DOP_W_Teat DOP-W 20001 1§
7 USE  VideoOOT EHMI_work DOP_W_Teat DOP-W 20001 1§
B Tom =] ¥ideodtd E:EMI_work DOP_W_Te:t DOP-W 20001 x5
©
0K [ Cancel |
After execute Export, it will ask users to select storage
device.
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Example of Video
(Table 2-4) Example of Video

Video Lists Output Setting \ by |
Video List
D | Save Local Video Name Source | P
1 UsB Video0O1 E/HMI_workDOP_W_Test'DOP-W 2.00.01 xx
2 |USB |VideolO2 Browse for Folder == Delete
3 USB Video003
4 UsB Video004
¥ Use Video003
HyperSnap 6 -
6 UsB ‘Video0O6 . Perflogs
7 UsB Video0OT > Program Files
8 USB Video008 > Program Files (x86)
Users
Windows

> ey CD Drive (D:)
i

+ | hmi (Whoxsvr) ()

New folder -~

i

| Export |

o [ e |

After press OK, it will export the video to USB device.

O Please select Element = multimedia and establish a video.
® Double Click the video and set parameter as below.
A. Set control address as $201.

B. Press @ icon to add video file to play list.
C. The play list of added video file.

'_9)'0 Element Properties
Control | 5201 E] | QJ
Play List
D |Mode |Name | il@
. 1_ Address  {EtherLink? 1}1@DI10 =
Vldeo 1_ File 115200
3_ Address  {Link2}1@D20
4 Address  {EtherLink? 1}1@D3
i_ File Tom2 @
"] Repeat
@ |[ 0K ]l [ Cancel I

© After complete the setting, please press OK to finish the
Video parameter.
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Example of Video
(Table 2-4) Example of Video

» Create Maintained button and set address as $201.0.

Maintained
Create Preview - & Text Picture Details Mz
Maintained Memory
Button
. Write Addrezs:
(Video Video Play 010 g
Play)
Read Addrezs:
None [:]
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Example of Video
(Table 2-4) Example of Video

O Create three numeric entry elements and set as below
address like {EtherLink2 1}1@D10, {Link2}1@D20 and
{EtherLink2 1}1@D5.

® Set Data Type to Word, Memory Format to Unsigned
Decimal, the Minimum value is set as 0, the Maximum value is
set as 65535.

Create
Numeric QJ { @
Entry W-(EtherLink? 1}1@D1 e
elements Edaed DaaType  [Wed ]
T MemoryFom
W-{Link2}1@D207 Edit System Keypad =)
HHHHH
e Minimum 0
Maximum 65535
W:{EtherLmk2 1}1@D3 ]
#HHHE e i —
- =
Compile
and » After finished above setting, please execute compile at
Download first, and then download all screen data to HMI.
screen |» Please insert the USB device to HMI before start to play
data to video.
HMI
O Please set value as {EtherLink2 1}1@D10 =2,
{Link2}1@D20 = 6 and {EtherLink2 1}1@D5 = 1.
Yideo List
Specified address value
ID | Save Local Video Name
0 <H—p» [T (o o0
1 4—» Tus  usnm
2 P > 3 D History
0 3 : : 4 sD Entry
Operating i : > [T Juse T
HMI 6 Gy |EWUSE  |Toml
7 P |7 USB Tom2

EtherLink2_1}1@D10 = 2 | Play History video file

{Link2}1@D20 = 6 Play Tom2 video file

{EtherLink2_1}1@D5 =1 | Play 115200 video file

® Press the $201.0, HMI will play the video.

© Press the $201.0 again, HMI will stop to play the video.
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3~VNC

VNC (Virtual Network Computing) is a PC software used to help the
customers view and check the same screen shown on W series of HMI at the
production site, and control the manufacturing process via Ethernet. No matter
where you are, remote controlling is not an arduous task at all.

3.1 Connection introduce for HMI

& Create HMI Project File
Start DOPSoft software program for w series and click File > New
or click New icon to create a new project. Then, click Element >
Input > Numeric Entry to create two numeric entry elements ($3
and $6) on the screen. In this case, W105B type DOP W series

HMI is used.

Hoosi tlRe .
File Edit View Element Screen Tools Options Window Help

|[*EEB 2¢ xhEhBRS 2Q | JRQAJ[CD &M

s~ AR AR A A|A - E ...J|[|_anguage1 v]|| o )
QaeamEa2QRFENEF am-f =M 2 OOE /@I H &0
z“ulf&:men_l

[

®

£

A

g $3 R

&=

$6 ’ e J

Use Screen Cycle Macro and enter the following commands in macro
command window.

S E@B ¥ B B E S W[ Sereen i [Soreen Cyole Macra]

153 =563 + 1
256 = 56 + 3
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Click Options > Configuration > Network App > LocalHost, check the
Application (Net App VNC) function Enable. Then, press OK button to finish

the settings.

LocalHost | SMTP
Locathost
EMI M
upload‘download port 12346
; Modbus TCP Server Port 302
Print
-‘7;‘ Network App(eServer)
= Enable Password 12343678
Default @
&;2 Scan Time
‘ Port
Others
Interface
MNetwork App
Net App (VNC)
Enable Pazzword 12345678
por o0

| ook [ came |

After finishing above setting, please compile and download all screen data

to HMIL.

021-87700210




3.2 VNC Setting
There are three ways to use VNC Viewer to connect with HMI.

® Computer Software

® Web Browser
® Android App

3.2.1 Computer Software

= Software installation
Please following the below URL link to download VNC software which
adapt the operating system.
http://www.realvnc.com/download/vnc/latest/
After double clicking VNC-5.2.0-Windows file downloaded from the
website exe file, the following dialog box will appear. Click on Run button
to install VNC.

Please click on Next.

- ™
i3 VNCISetup [

n VNC?Setup Wizard
‘ This will install VMC 5.2.0 on your computer.

If a previous version is detected, and connections to YMHC
Server in Service Mode are currently in progress, users will be
temporarily disconnected. Users can immediately reconnect as
soon as YMC Server upgrades.

Lsers connected to YMC Server in User Mode will not be
disconnected. VNC Server in User Mode is not upgraded until
the next time it is started.

Click Mext to continue, or Cancel to exit Setup.

[ Mext = J I Cancel
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Please choose | accept the agreement, and then click on Next.

-
i5 VNCISetup ==

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

WMC EMD USER. LICEMSE AGREEMENT -

IM ORDER. TO INSTALL ANY PART OF THE SOFTWARE (AS DEFINED BELOW),
AMDOR TO RETAIN THE SERVICES OF REALVMC, YOU MUST FIRST ACCEPT

THE TERMS AMD COMDITIONS OF THIS AGREEMENT. BY USIMG ALL OR. ANY
FORTION OF THE SOFTWARE YOU ACCEPT ALL THE TERMS AMD COMNDITIONS

OF THIS AGREEMENT. YOU AGREE THAT THIS AGREEMENT IS EMFORCEAELE

LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGMED BY YOU. IF YOU DO

MOT AGREE THEN DO MOT INSTALL OR. USE ANY PART OF THE SOFTWARE. BY
INSTALLIMG AMY LUPDATED VERSION OF THE SOFTWARE WHICH MAY BE MADE ™

(@ I accept the agreement

() 1 do not accept the agreement

[ < Back ][ Mext = ][ Cancel

Please check all components, and then click on Next.

o =
15 VNC?Setup =L
Select components
Which components should be installed?
Select the components you want to install; dear the components you want to
uninstall.

A separate installer will launch for each selected component.

Click Mext when you are ready to continue.

WMC Server
WMC Mirror Driver
WMC Printer Driver
[¥] WNC Viewer

< Back ][ Mext = J[ Cancel
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Select the default directory C:\Program Files\RealVNC\VNC Server, and
click on Next button for the next step. To select a directory other than the
default directory, click Browse.

f 7 B’
iB) VNCSetup ESNEE
Select VNC Server Location Vn

Where should YMC Server be installed? C

WMC Server will be installed in the following folder.

To continue, dick Mext. If vou would like to select a different folder, didk: Browse.

\Program Files\RealVNC\WING Server

[ < Back ][ Mext = ][ Cancel ]

Select the default directory C:\Program Files\RealVNC\VNC Viewer,
and click on Next button for the next step. To select a directory other
than the default directory, click Browse.
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8l VNC7setup = | ey

Where should VMC Viewer be installed?

Select VNC Viewer Location Vn

WM Viewer will be installed in the following folder,

To continue, dick Mext. If yvou would like to select a different folder, didk Browse,

C +\Program Frles J'.-_-al EWEF ;

| <Back | Next> | | cancel |

User could check create a VNC Viewer desktop icon option or not and
then click on Next.

5 VNC7setup = ey

Which additional tasks should be performed?

Select Additional Tasks Vn

Select the additional tasks you would like Setup to perform, then dick Mext.

Additional icons:

[7] Create a VNC Viewer desktop icon

<Back || Next> | [ Cancel
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Please check the Add an exception to the firewall for VNC Server,
and then click on Next.

L

i3 VNCISetup

Firewall Configuration
Add a VMC Server firewall exception

To enable users to connect, an exception must be added to the firewall, YNC Server
can attempt to add this exception, or you can configure the firewall yourself.

Mote that some firewalls may prevent VNG Server adding an exception, If users

experience connection problems, examine the firewall's settings.

Add an exception to the firewall for YMC Server

[ < Back ][ Mext = J[ Cancel

)

Please click on Install button to install VNC.

15 VNC?Setup

Ready to Install
Setup is now ready to begin installing YMC on your computer,

Click Install to continue with the installation, or dick Badk if you want to review or

change any settings.

Upgrading YMC Server (5. 2.0):
Install mirror driver
Install printer driver
Add firewall exceptions

WMC Server destination location:
C:\Program Files\RealVMC\WHNC Server

Upgrading YMC Viewer

WMC Viewer destination location:
C:\Program Files\RealVMCWHC Viewer

»

m

<Back || Instal

] [ Cancel
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Click on Finish button to complete VNC setup.

r@ VNC?Setup s sizin| i |

n VNC?Setup Wizard completed
‘ Setup has finished installing YMC on your computer.,

Click Finish to exit Setup.

< Start VNC Viewer

Start VNC Viewer and following as below setting, click on Connect.

# VNC Server : Please input VNC Server IP Address and

connection port. The IP Address is HMI IP Address and the
connection port is click Options > Configuration > Network
App > LocalHost of DOPSoft, set port of the Application (Net
App VNC) function. The connection example for HMI IP Address
is 192.168.123.26:5900. If DOPSoft software changed the port to
5902, the VNC Viewer must be input 5902 to connect.

# Encryption : Please select Let VNC Server choose.
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.—W VNC Viewer o=EE
VNC® Viewer E
VINC Server: | jilelc e saets s -
Encryption: ’Let‘l.-'NC Server choose v]
[ About... ] [ Options... I
b,

If connection is successfully, it will appear the following window
to remind user this connection is unencrypted. User could ignore
this warning and click on Continue.

I F ™y
Ve VNC Viewer - Encryption ﬁ

0 Unencrypted connection

The connection to this VNC Server will not be encrypted.

WMC Server: 192188123 26::5900

Your authentication credentials will be transmitted securely, but all
subsequent data exchanged while the connection is in progress may
be susceptible to interception by third parties.

| [C] Don't warn me about this again.

| [ Continue ] [_ Cancel _]

A

L

But if connection is failed, it will appear the following window. It
means the IP address does not exist or the VNC network
application is not enabling.

o = B!
VNC Viewer -

./-_-\I\.
I'QI Timed out waiting for a response from the host computer
k.

L

After connection successfully, VNC will ask user to input the
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connection password for HMI and VNC. The password is DOPSoft
Network App password setting of VNC, default is 12345678.

V2 WMNC Viewer - Authentication ﬁ

WMNC Server: 192.168.123.26::5900

Lsername:

Password: ©0000000|

[ oK ][ Cancel ]

—-— = ";|

If type incorrect password, it will appear the following message.

£ = I
VNC Viewer -

k. J

After authentication pass, the connection is established.

V2 WindowsCE - VNC Viewer l —_—
FHE X290
$6 171 H
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3.2.2 Web Browser

VNC Viewer also provide web browser, it is have an easy connection
way with typing HMI IP address and port number.

Note :

v' The default connection port number for web browser is 5800. Please
do not set the connection number port to 5800 in VNC network setting
in DOPSoft. If user set to 5800, after download to HMI, it will appear
following as below message to inform user to change port number.

v" It needs to install JAVA to open the browser.

021-87700210
NIC SANAT



Step1. Open the web browser, for example is using Google Chrome.
& Google Chrome browser connection example:

Please type the IP address and port number:
http://192.168.123.48:5800/.

& |E browser connection example:

Please type the IP address and port number:
http://192.168.123.26:5800/.

& Firefox browser connection example:

If use Firefox browser to connect, please turn off the proxy at first.
Then type the IP address and port number:
http://192.168.123.26:5800/.

If type incorrect IP address, it will not display any content.

[7 192.168.123.26:5800

Embedded

Ve

VMG Viewer Free Edition 4.1
Credits:
Feica Chen (China)
Johan Henning Metherlands)
See hitpiiwanan efon.co for information on W C.

After typing the correct IP address, it will appear following as below
window, please click on OK.

(o . .
| £ VINC Viewer : Connection Details E@g

Semer;HHQE.IEE.IES.EG:D

Encryption: 'N-:ut supported

About... | Dptinns...l Ok Cancel
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Step2. Please input the password to connect with HMI, the default
password is 12345678 which set from DOPSoft VNC.

- R v 4
| £| VMNC Authentication [No Encrypti... lilﬂlﬂ;hj

]m**mm|

Password:

L8 A

If type incorrect password, it will display as below error message.
r-—_*.-. [‘:‘ Gl ﬁ |

rfb. AuthFailureException: Authentication failure

Step3. After authenticate successfully, the connection is established.

rlél VNC: WindowsCE =) . ) |
$3 3303 H
$6 9917 H
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c. Android App
Please get the VNC Viewer App from Google play store at first.
After download, please execute the app to finish the following
steps.

Step1. Please click on the bottom left corner [ + ] to add new

connection.

UNC Viewer

1G2.168.0.105:5G00
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Step2. Input the connection IP address and connection name.
(1) Please input HMI IP address and port number.
(2) User could custom the connection name.
(3) Please do not check the save password option.
)

(4) After finishing above setting, please click on the below icon.

Details

@ 1G%2.168.0.105:5G00

@ WI10K’B

 Save Rassword [ ]

@
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Step3. Complete the setting, it will display as below figure.
Please click on Connect.

g V¢

Connect

ADDRESS

)

1G2.168.0.1 05:5G00

NAME
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If input the incorrect IP address, it will appear the following message.
8 & g% | 1:0G

The computetr's IR address could not
be contacted.
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Step4. It will ask user to input the password to connect with HMI, the
default password is 12345678 which set from DOPSoft VNC.

Cancel
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If input the incorrect connection password, it will appear the following
message.

Invalid authentication credentials
supplied.
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Stepb. After authenticate successfully, the connection is established.

$6 550 H
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3.3 VNC Viewer Detail Setting
After the VNC Viewer connected with HMI, move the mouse to the
upper window, it will appear the tool bar.

V2 WindowsCE - VNC Viewsr |I = ||
B AEE S O
$3 44 H
$6 171 H
The following table will introduce related function.
New . ,
@ . Use new connection could operate multiple HMI.
= connection

1. Click on @ it will appear as below window to type another HMI IP

Address for operating.

e F !
W2 VMNC Viewer [':' = iﬁ]

VNC® Viewer VE

VINC Server: | IEERL EREER-E]

-

Encryption: [Let‘l.-'NC Server choose v|

[ About... ] [ Options... I

e A

2. After new connection establishing, the VNC Viewer is connecting with two
HMls.
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Vi WendowsCE - VNC Viewer

0 0 0.0000

0.0 0.00000
| - ™ _| i 2 0.00 0.000000
0.000
1 i 1 $17n 2 (] GETHESTORY.
36 Pt J [} ('] o 1] o 0 0 [t} Q
[ (1} o a o 0 i} 0 a
Butfer 1 GET. Cles Bufter 2 QBT iClass Al
[ % FEO06 LE0HD | o 0704 OLAEO0E 105D 11060 .
n.m:u'ﬁn’mxmr a7nEaT muw L10ea 0,
TS 48 GL2E/2000 LLDS] 70 48 0LTEIT006 DA L1086 [}
€1/t B O37aN006 11087 3739 G006 (1000 LIAT
" CFAE £5 OI/OHF008 TE0] 070238 0222008 LIOTS 11070
Chitm 28 GaRiEms 10 |+ Q1 0B O0 GIARAN UOT oW -

‘ O r

Save The save connection function could save the
Y
Q , configuration for next time connection. User executes
Connection ) ,
connection without type IP address and password.

1. Click on E , it will appear as below two windows.

-
Passwaord Behavior ﬁ

What do you want to do with the VMC Server password for 192, 168,123,497

-~

(7 Don't save VMC Server password
@) Save YMC Server password
() Encrypt WNC Server password (recommended)

[ Don't ask me this again

[ oK ] [ Cancel
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i !
i@ VNC Address Book EM

File Edit WView Tools Help

El V. 2.9
Alphabetic | Hierarchical

Your address book is empty

Details

YNC Server;
Encryption:

Username:

Options:

0 entries Master Password: Stored
L o

Please choose Save VNC Server Password in Password Behavior
window, and then click on OK to save connection.
After saving, the configuration is saved as to VNC Address Book.

i !
i@ VNC Address Book EM

File Edit WView Tools Help

El 7.%.9-
Alphabetic | Hierarchical

11
Ve 192.168.123.26

Details
VMNC Server: 192.168.123.26
Encryption: Let VMC Server choose
Username: TIMA.Q.LEE
Options:
1 entry haster Password: Stored
L5 o
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User also saves multiple connections as below figure.

i !
i@ VNC Address Book E@ﬁ
File Edit | View | Tools Help
A X
Alphabetic | Hierarchical |

12
VB 192.168.123.26
VP 192.168.123.49

Details
YNC Server; 192,168.123.49
Encryption: Let VMC Server choose
Username: TIMA.Q.LEE
Options:
2 entries Master Password: Stored
L A

Only start VNC Address Book and select the connected IP address when
next connection.

2] Close Close connection will close VNC Viewer with HMI

pre—l

== Connection | connection

Click on =% | it will ask users the following question.

VNC Viewer et

:_I Are you sure you want to disconnect?

Yes J | Ma

L A

Click on Yes, it will close the connection.
Click on No, the connection is still connecting.

Detailed setting for VNC Display, Inputs,

% Options Troubleshooting, and Expert. All of these
configurations is VNC original setting, and use default

parameters to connect with HMI. Therefore, this part
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does not describe more explanation.

Full Screen L

The function is display full screen.
Mode

Connection o , i
ﬂ , Get more connection information for VNC Viewer.

Information

f !
V2 WMC Viewer - Connection Informaticn ﬁ

Desktop name:
VMC Server:
Size:

Pixel format:

VMC Server default:

Requested encoding:

Last-used encoding:
Line-speed sstimate:
Protocol version:
Security method:
Connection type:

Extensions:

WindowsCE

192 168.123 265900

800 x 600

depth 15 (16 bpp) little-endian rgb555
depth 15 (16 bpp) little-endian rgb555
TRLE

Hextile

20000 kbit/s (RTT ~0ms)

3.8

VnchAuth [no encryption]

Dhrect TCP

021-87700210
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4 -~ e-Printer

ePrinter offer users in HMI without connecting entity end printers can print
directly through the Internet, space-saving and printing hardware devices
convenience. Please refer to as below structure of ePrinter.

ePrinter through the PC as the agency role, in

the PC side open PrnServer, then set the IP ey ([
address of the PC in HMI. Report button 7 - _
element triggered by the HMI, you can through R Lserer
the Internet to deliver any print file fo a PC 000 Seses Eg
connected any printer. P
|
o
. 0 Eam——— & EPSON
= LO-300+ /4
ESC/P 2

HMI Ethemet

e-Printer function could described as two parts. Fisrt is introduce for PrnServer;
Second is how to set HMI connect with ePrinter to print.

4.1 PrnServer

PrnServer is an execution file, users could start the PrnServer and deliver file
to print through Ethernet.

PrnServer execution file location as below path C:\Program Files (x86)\Delta

Industrial Automation\DOPSoft 2.00.01\PrnServer.exe.
| 0000 @
DELTA -

Delta Industrial Automation

; Communication

; HIMI

, DOP eRemote 2.00.10

, DOP eServer 1.00.20

, DOPSoft 1.01.08
, DOPSoft 1.01.10
. DOPSoft 2.00.01

E;!l DOPSoft 2.00.01

FlashTransfer

m

PrnServer
& Uninstall
. Screen Editor 2.00.23
, PLC
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After start the PrnServer, it will show as below.

£ Prerver
Frinter[}  Helpity

L

As below table will describe for PrnServer.

Printer

» Before execute print action, please press
Start to connect to printer server.

» The default printer port is 85 and it will
connect to the default printer of PC

automatically.
Start

.é PrnServer
Printer(F)  Help[H}

SEE .

ISTART Connect to port 85
Seup printer to Microsoft XPS Document Writer

» Press Stop to disconnect the connection, it
will display as below following message.

ﬁ PrnServer
Printer(F} Help[H}

Stop =2 B ol

START Connect to port 85

j ¥P5 Document Writer
STOP Connectting

Setting B2 | > Display printer detailed setting.
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Print @

Printer
Mame: [Micmsoﬂ XPS Document Writer v] [ Properties... ]
Status: Ready

Type: Microsoft XPS Document Writer
Where:  XPSPort:

Comment: Prirt to file
Print range Copies
@ Al Number of copies: 1 =
Pages 0 0
() Selection _11ﬂ _2IE _3'13
[ ok ][ cancal |

» Users could change the wanted printer to
connect.

i Print @

Printer

Mame: [I‘u‘licmsoﬂ KPS Document Writer v] [ Properties... ]

. Fax
Status: |y — T
Type: MICrOSOT AR LoCUMENT VVmer

Where:  XPSPort:

Comment: Print to file
Frint range Copies

@ Al MNumber of copies: 1 o

Fages

() Selection —1’g —2’J —3’E

[ ok ][ cancel |

» Press Exit will close the PrnServer.
» When users do not seed to use PrnServer
to print, please press Exit to disconnect the

connection. If press ————== to close, it will
not stop the connection. When start the
PrnServer again, it will display as below

Exit _ _
following message to inform users.
PrnServer @
PrnServer does exist ..
Help | About ® | > Display current version of PrnServer.
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About PrServer Iﬁ

4

PrnServer, Version 1.0
Copyright (C) 2012

4.2 HMI connection setting

This part is designed to allow users to understand how to set ePrinter function
in the HMI screen, and trigger action to complete the print through HMI.

& Create Project

Please select W105B, and set print as ePrinter.

Project Winzard B
Series f HMI List
|DOP-w series | | wodel Type Resolution  Color c
| wiosB 800 * 600 55536 Colors | 0)
W127B 10247768 65536 Colors
W1s7B 1024*768 65536 Colors
Project Setup
Project Name: NewHMI
Screen Name: Screen_1
Sereen No 1
Printer Ii ePrinter 'I 9)
System Message Language [Enghsn v]
HMI Rotation degree
B [ e ][ camel |[ Fuih
Click Next to finish communication and Ethernet setting.
Broimet Wintard Project Winzard L7}
- Commmeratum Seiteg
o] r—
coan
Lk e -
‘.E Comretier T D VPR
COM2
Mst Dvop Dbl
(] ]
coun - b
o CrommweePmmes  Cems - s
~rtit ML Stson p—
lererface LI
EM"'MZ DBty Be
Soop By 1 B
Bt By )
Pty Evm
P Oyiicr
™ - Back Comee -
www.nicsanat.com
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& Printer setting

Select Options > Configurations=»Print and choose Ethernet at Interface, fill
IP address and printer port.

Configuratien (=24
!ga? Standard Tnterface
Wain ‘[’ Printer USB 1.1 IHHHHI (EL
!Hh V4| & eprinter - SO T
Paper 5
Control Block i3 192 . 168 . 123 . 68
les ) ©
[=] Port 8 ~
Quality
Print | 72DP1 Zi |
= .
Vs Margin
Default Top: 0 S mm
- Direction
K}{ Bottom: 0 S mm
: i @ Vertical Horizontal
Others Left: 0 S mm
i}gP Right: 0 S oam
Network A
i Print Size
Width 210 mm 210X 297 mm
Ratio: 100 [¥] Auto Nest Page
Height 297 mm
Ratio: 100
[ ok [ cme |

v |P Address : ltis filled IP address of the PC which starts PrnServer. User

could type ipconfig command in Command Mode to check the IP address
in PC. For example is 192.168.123.68.

Note :

| # The IP address of ePrinter needs to locate the same domain with HMI I
screen IP address.

B Administrator: C\Windows\system32\cmd.exe EI@

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix . : imsbu.iabg.com

Tink_laoca uf Odduwac o LI 4 DF - Fed:24F 4211
IPv4 Adde B .123.68

i_)l.l;JIIUI. iicl

Default Gateway
Tunnel adapter isatap.imsbu.iabg.com:

Media State : Media disconnected
Connection—specific DNS Suffix . : imsbu.iabg.com

Tunnel adapter Teredo Tunneling Pseudo—Interface:

Connection—specific DNS Suffix . :

IPvb Address. . - . . . . . . . . & 2881:8:9d38:6abd:3Bae:1chf=f5ff:fdfm
Link-local IPv6 Address . . . . . = fe8@::3Bae:ichf:fSff:fdfBx13

Default Gateway 8 88

C:slsersstinar

v' Port : The default printer port is 85. When open PrnServer connection, the
connected printer port is also 85 like as below figure.

Jf.i PrnServer
Printer(F} Help(H]
VA ©

START Connect to port 85
eup printer to Micros Document Writer
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& Create Report List element
Create Rectangle, Circle and Report List button elements in DOPSoft screen,
and then set report device to Printer in Report List button.

==

Report List
Preview - Main Text Picture Details Macro Coordinates
I
Style Detail
. Style: Report Device: USE Disk -
Print
Foreground Color: [ 4
EJ1-Screent
Print

& Execute compile and download all screen data to HMI.

& After press print button, please start the PrnServer and click start to

connection.

ﬁ PrnServer

Help(H)

(==

START Connect to port 85
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Seup prnterto Microsoft XP5 Document Whiter

021-87700210
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